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Introduction

 Introduction

The Inepro Card Reader Service can be installed on the Smart Operation Panel (SOP) of a Ricoh MFP
device.
It is used to upload new firmware or another configuration to the Inepro card reader or to change the
configuration of the service itself.
This manual is for the Ricoh SOP (Generation 2 and Generation 2.5) and will instruct you on how the
service can be installed and used  
See 'Terminology: MFP on page: 
See 'Terminology: SOP on page: 

5
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Terminology

 Terminology

Some of the terms in this document might be unfamiliar, these are explained in more detail in this
section. In the rest of the document references have been made to this section. Go to the page
number in the reference to look up the term.

ISV - Independent Software Vendor
An independent software vendor (ISV) is an organization specializing in making and selling software,
as opposed to hardware, designed for mass or niche markets. This is in contrast to in-house
software, which is developed by the organization that will use it, or custom software, which is
designed or adapted for a single, specific third party. Relevant to Ricoh SOP (Smart Operation Panel);
an ISV only needs the Inepro Card Reader Plugin, it will write the embedded software themselves.

RED - Remote Embedded Deployer
RED (Remote Embedded Deployer). This tool is used for installation and configuration for Inepro's
DocuPRO embedded products.

Card
Cards (in Inepro terminology) are objects that have a chip (either pure on the inside, or also visible
from the outside), that can store data (for example; the users current balance) and have a unique ID.

Tag
Tags (in Inepro terminology) are child objects of an Account that have a chip (either pure on the
inside, or also visible from the outside), that cannot store data (for example; the users current
balance) and have a unique ID.

WIM - Web Image Monitor
Ricoh Web Image Monitor allows users to remotely monitor and change the network configuration of
Ricoh copiers, multifunctions and printers via common web browsers. Ricoh WIM can be used to
install our solution if somehow our Remote Embedded Deployer can not perform the installation.

Check printer status
Once you have entered the right IP address, you can use common browsers to see whether the
printer is ready or not.

Platform independent
Because Web Image Monitor works via web browsers rather than PC software, it is platform
independent and can be used with any operating system. As long as the target printer is networked
and has an IP address, you can check its status at any time.

User-friendly monitoring
Using Web Status Monitor is as easy as browsing the internet. Simply type in the IP address of the
printer to check, and an HTML page will appear with the status of the target peripheral.
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SP Settings - Service Program Settings
The Service Program (or SP) Settings are the settings within the MFP device used to configure
behavior, enable or disable hardware, and manage other type of configuration.

SOP - Smart Operation Panel
The Smart Operation Panel is the touch screen panel on the MFP. It offers a simple, flexible way to
work. A quick UI gives one-touch access to common functions like copying and scanning or total print
job control, intuitive UIs make even the most complex layout and finishing options easy to preview
and configure. The panel allows for a visually unique and tailored look, layout and content of the
interface.

SLL -  Secure Sockets Layer
SSL or TLS (Transport Layer Security) certificates are data files that bind a cryptographic key to the
details of an organization. When SSL/TLS certificate is installed on a web server, it enables a secure
connection between the web server and the browser that connects to it. The website's URL is
prefixed with "https" instead of "http" and a padlock is shown on the address bar. If the website uses
an extended validation (EV) certificate, then the browser may also show a green address bar.

What is SSL used for?
The SSL protocol is used by millions of online business to protect their customers, ensuring their
online transactions remain confidential. A web page should use encryption when it expects users to
submit confidential data, including personal information, passwords, or credit card details. All web
browsers have the ability to interact with secured sites so long as the site's certificate is issued by a
trusted certificate authority. Inepro uses SSL to keep personal information and such secure.

MFP - Multi Functional Printer/Product/Peripheral
An MFP (Multi-Function Product/ Printer/ Peripheral), multi-functional, all-in-one (AIO), or Multi-
Function Device (MFD), is an office machine which incorporates the functionality of multiple devices in
one, so as to have a smaller footprint in a home or small business setting (the SOHO market
segment), or to provide centralized document management/distribution/production in a large-office
setting. A typical MFP may act as a combination of some or all of the following devices: E-mail, Fax,
Photocopier, Printer, Scanner.

Smart SDK - Smart Software Development Kit
RICOH SmartSDK is the web API used for controlling Ricoh’s MFP from the applications displayed on
SmartOperation Panel installed to MFP and from the applications which run on external application
servers.
Inepro uses RICOH SmartSDK to control scan jobs, copy jobs, device management, and log
management.

SDKJ - Software Development Kit for Java
Ricoh’s Device SDK Type-J (SDK/J) is a state-of-the-art application development environment that
allows for the creation of customised embedded applications that run on Ricoh Multifunction Products.
SDK/J is based on the Java ME technology and controls most aspects of device operation, including
the control panel, and core capabilities such as printing, scanning, faxing and saving files. It is the
previous SDK, the current SDK is Smart SDK.
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Terminology

JRE -Java Run-time Environment
Java Runtime Environment (JRE) is a runtime-environment (software) made by Oracle that make it
possible to execute Java-programs on a computer. Java Runtime Environment consists of a Java
Virtual Machine (JVM) and everything around it necessary to execute Java programs, like an
implementation of the standard-API. Java-programs in a browser are called Java-applets.
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Prerequisites

 Prerequisites

Name

Ricoh

Ricoh MFP with SOP (Smart Operation Panel) Generation 2 or 2.5

MFP must have an SSL certificate enabled!

Smart SDK firmware on Ricoh MFP  2.40 or higher

System firmware on Ricoh MFP 1.9 or higher, SSL Enabled

Application System firmware on Ricoh MFP 1.16 or higher

SDKJ version on Ricoh MFP 12.8 or higher

Inepro installation files

Remote Embedded Deployer (RED) 7.18 or higher

Inepro Reader Plugin.zip 7.18

Logical Ports

MFP - Incoming (from computer executing installation)

TCP 23, 80, 8080, 443, 51443

View the port overview below to correctly configure the ports.
See 'Terminology: MFP on page: 
See 'Terminology: SOP on page: 
See 'Terminology: Smart SDK on page: 
See 'Terminology: SSL on page: 
See 'Terminology: SDKJ on page: 
See 'Terminology: RED on page: 

Port Overview

 Please make sure the prerequisites are met, before continuing

5
5

5
5
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Credentials

Credentials

In the processes described in this manual, Ricoh credentials are necessary.

Ricoh Credentials
The Ricoh WIM (Web Image Monitor) credentials are needed to install the Inepro card Reader
Service, these should be known and can be obtained from your multi-functional device dealer  
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Installation

 Install the software on the multi-functional via RED

Installation
1. Obtain the installation files:

Remote Embedded Deployer (<VERSION NUMBER>).zip: 

2. The version of the Remote Embedded Deployer (RED) must be equal to or higher than 7.18.
See 'Terminology: RED on page: 

3. Make sure Java Run-time Environment (JRE) is installed or extract the entire directory
structure and files from the *.zip file.

See 'Terminology: JRE on page: 

4. Open the Remote Embedded Deployer (Start Remote Embedded Deployer.exe).
5. The Business server Address is not needed, click cancel.

 

4
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6.  Click 'Browse'.

7. Select IneproReaderPlugin_<Version>.zip.
8. Click 'Open'.
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Installation

9. Make sure the 'Install Only' option is selected in the Settings menu.

10. Add one or more devices by clicking 'Add', a dialogue box will appear.

11. Make sure the Web Image Monitor (WIM) credentials are correct.
See 'Terminology: WIM on page: 

12. Tick the IM box if you are using Generation 2.5, else if you are using Generation 2 leave it
unchecked.

13. Click Scan or add one or more IP-address to the list and click 'OK'.

14. By default all devices are selected, click 'Refresh' to get the device details.

 Please make sure that the following ports are open in the network:
Depending on the MFP's device certificate (SSL) TCP port 80 or 443 for traffic to the MFP.
TCP ports 8080 and 51443 for traffic to the MFP.

See 'Terminology: MFP on page: 
See 'Terminology: SSL on page: 

4
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15. Select the applications you want to install.
16. Select the devices you want to install the applications on.

 If you do not use an Inepro USB card reader, please uncheck the 'Configure Card Reader' option,
under the 'Settings' menu!

17. Click 'Install'.
18. The device will get the status 'Busy: initializing' and start to install the Inepro Reader Plugin.

 

19. Installing...
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Installation

20. Wait until the device status of all the selected devices has returned to 'Idle'.

21. This can take a couple of minutes depending on the number of selected applications.
22. The details column should show 'Successful' as the outcome of the action.

23. By double-clicking the device a installation result report will be shown in the summary section.

Other RED (Remote Embedded Deployer) Functions
The RED has more functions than those described here.
More RED functions are treated in Appendix VII: Red Functions on page  
See 'Terminology: RED on page: 

 Install Card Reader - For G2.5 devices

The RED will automatically install the card reader and set the SP settings in the MFP, but in case this
must be done manually; use these instructions:

1. Please login to the Administrator menu.

4
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2. Go to 'User Tools' -> 'Screen Features Settings':

3. 'Screen Device Settings'
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Installation

4. 'External Interface Software Settings'

5. 'Select IC Card Reader' 
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6. Select 'Proximity Card Reader':

7.  Connect the Inepro Card Reader to the SOP, preferably on the internal USB Mini-B port on the
right side of the panel, behind the cover. The USB-A port on the left side could be used as an
alternative.
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Installation

8. Wait for about 5 seconds for it to become visible.

9.  The Inepro Card reader should now be available. Click on the reader.
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10. Select 'Inepro Card Reader'

 Install Card Reader - For G2 devices

The RED will automatically install the card reader and set the SP settings in the MFP, but in case this
must be done manually; use these instructions:

1. Please login to the Administrator menu.
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Installation

2. Go to 'User Tools' -> 'Screen Features':

3. 'Screen Device Settings'
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4. 'IC Card / Bluetooth Software Settings'

5. 'Select IC Card Reader' 
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Installation

6. Select 'Proximity Card Reader':

7.  Click 'Proximity Card Reader Settings'.
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8.  Connect the Inepro Card Reader to the SOP, preferably on the internal USB Mini-B port on the
right side of the panel, behind the cover. The USB-A port on the left side could be used as an
alternative.

     

9. Wait for about 5 seconds for it to become visible.
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Installation

10.  The Inepro Card reader should now be available. Click on the reader.

11. Select 'Inepro Card Reader'
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Troubleshooting

 Troubleshooting

Sometimes things do not work out as expected, if so please read through this section before
contacting your service organisation or dealer. Chances are you are able to solve the issue yourself.
The section is set up in a symptom - Prognosis - Resolution format, that is first the symptom is given,
then the possible causes and then the resolution for those causes.

 Symptom(s): Device has the 'Error' in the RED (Remote Embedded
Deployer) and can not be installed

 Prognosis: The device is in an error state, devices in 'error' state may not
be used.

 Scope: All Devices that have the 'error' state in the RED.

 Resolution(s): 
A - Refresh and retry.
  1) Refresh the device device, and wait a moment for the status to change.
  2) When the device does not longer have the 'Error' state, try starting the install procedure again.
B - Contact your service organisation or dealer for further solutions.
See 'Terminology: RED on page: 

 Symptom(s):  'Customer not found' error message when trying to log in as
administrator on the MFP

 Prognosis:    MFPAdminUserName  and / or     MFPAdminPassword   are
incorrect

 Scope: All devices in the same BS settingsgroup

 Resolution(s):
A - Verify the username and password in the Business Server Settings: 'MFPAdminUserName' and /

or  'MFPAdminPassword', they should match the MFP's username and password for the
administrator account. Note: MFPAdminUserName is also case-sensitive, just like the
MFPAdminPassword, in other words: 'AbC' is not the same as 'aBc' and 'Admin' is not the same
as 'admin'.

See 'Business Server Configuration: MFPAdminUsername on page: 
See 'Terminology: Business Server on page: 

 Symptom(s): Instead of starting the Ricoh launcher an application is
opened directly.

 Prognosis: The function priority setting is set to an application.

 Scope: All Devices

 Resolution: 
A - Uninstall the launcher, to enable you to get to the settings.
B - Change the function priority setting.
  1) Go to the Settings menu.
  2) Go to 'User Tools -> Screen Features -> Screen Device Settings -> Function Priority'.

4
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 Symptom(s): Card Reader does not respond at all

 Prognosis: Reader is configured as 'HID RAW' device

 Scope: All Inepro USB Card Readers

 Resolution(s): 
A - Connect the reader to a laptop or PC and reconfigure with the Card Reader tool to a non-'HID

Raw' interface type.
  1) Connect the reader to a laptop or PC.
  2) Go to the 'Programmer' tab, and click 'Switch to program mode'
  3) Select the 'default.readerconfig'.

  4) Click 'Switch to normal mode'.
  5) Disconnect the reader from the PC.
  6) (Re-)Connect the reader to the SOP (panel)  See page: .
See 'Terminology: SOP on page: 

 Prognosis: Reader is not connected to SOP (panel)

 Scope: All Inepro USB Card Readers

 Resolution(s): 
A - (Re-)Connect the reader to the SOP (panel)  See page: .

 Prognosis: Reader is not configured in MFP

 Scope: All Inepro USB Card Readers

 Resolution(s): 
A - Configure Card Reader in the MFP. See page: .
B - Or run the RED again.
See 'Terminology: RED on page: 

5
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Troubleshooting

 Symptom(s): Error message 'Problem connecting to server'.

 Prognosis: The network cable is not connected or defect

 Scope: All Devices

 Resolution: 
A - Check if the network cable is connected.
  1) If not, connect the network cable.
B - The cable is connected but might be defect / damaged.
  1) Check if the cable might be defect.
  2) Replace the network cable to see if this resolves the issue.

 Prognosis: The network settings are incorrect

 Scope: All Devices

 Resolution: 
A - Please check the network settings.
  1) Check if the network card is in the correct range.
  2) Check if the network card has the correct subnet.
  3) Check if the network card has the correct gateway.
  4) Check if the network card is in the correct internal DNS server.

B - 
C - Ping the device from the server running the Inepro Business Server.
See 'Terminology: Business Server on page: 
See 'Terminology: MFP on page: 

  Symptom(s): The issue seems unsolvable on location

 Prognosis: The issue is unsolvable on location

 Scope: Every device on location

 Resolution: 
A - Contact your service organisation or dealer for further solutions

4
5
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Appendix I: Card Reader Config Upload

Card Reader config upload steps

The Card Reader Service Configuration Page can be reached using the following URL:

http(s)://<ip-address>/rws/sop/inepro/cardreader

After logging in, using the Ricoh credentials, the Card Reader Service Upload Page will be shown:

1. Select 'Card Reader Configuration'.
2. Click 'browse'.
3. Select the .readerconfig file.
4. Choose upload.

Please wait till you have seen the status message !

Updating configuration

 Note: In some cases after successful update message the status does not indicate
ready but offline, please refresh the page in the browser to accurately check the offline
status  
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Screenshot from the Inepro reader tool.

 Warning: Ricoh cannot work with the 'HID RAW' interface. Never set the
reader to the 'HID RAW' interface in combination with a Ricoh device.
If this interface type is used, the reader will be rendered useless untill it is
connected to a laptop or PC and reconfigured with the tool to a non-'HID Raw'
interface type.
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Appendix II: Update card reader

Update card reader firmware

The Card Reader Service Configuration Page can be reached using the following URL:

http(s)://<ip-address>/rws/sop/inepro/cardreader

After logging in, using the Ricoh credentials, the Card Reader Service Upload Page will be shown:

To update a new firmware, the two firmware files (digest and firmware) must be provided  
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Reader firmware upload steps

1. Choose Card reader firmware.
2. Browse and select both files, digest and firmware. (Click browse and select the files

simultaneously).
3. Choose upload.

Please wait till you have seen the status messages !

- Offline

- Erasing firmware

- Programming firmware

 Note: In some cases after successful update message the status does not indicate
ready but offline, please refresh the page in the browser to accurately check the offline
status  
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Appendix III: Uninstall the Inepro solution

 Uninstall the Inepro solution
In some cases you might need to uninstall the Inepro solution from the MFP's. This procedure will
uninstall all Inepro applications and revert all specific MFP configuration settings back to it's default.
Follow these instructions to do so.

Uninstalling via RED (Remote Embedded Deployer)
See 'Terminology: RED on page: 

1. Select the devices to uninstall.
2. Go to the 'Devices' menu, click 'Uninstall all Inepro Apps'.

3. The devices are uninstalling as can be seen in the status and details columns of the RED (Remote
Embedded Deployer).

 

4
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4. The device will reboot afterwards, please wait for the 'Successful' status. Review the
Uninstallation Summery be double-clicking the device.
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Appendix III: Uninstall the Inepro solution

Alternative Ricoh WIM uninstall
As an alternative to the RED uninstall method, follow the Ricoh WIM uninstall procedure. To uninstall
the Inepro solution the install steps must be carefully followed in reverse. Do not skip steps or change
the order in which the steps are taken. Mind the changed configurations, installed applications. And
use 'Uninstall' where it says 'Install' in the manual.
See 'Terminology: SP Settings on page: 

1. First follow the installing steps in this manual in reverse, finally continue with the steps below.
2. Go to Ricoh WIM (Web Image Monitor). Select Configuration under the Device Management

menu.
See 'Terminology: WIM on page: 

5

4
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3. Scroll down to the left bottom of the screen. At the 'Extended Feature Settings' section, click
'Uninstall'.

4. The first page of the Uninstall menu is shown.
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Appendix III: Uninstall the Inepro solution

5. Scroll to the last page. Select the apps you need to uninstall, like the 'Inepro Reader Plugin'
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Appendix IV: Deploy the solution manually

 Install the software on the multi-functional via WIM

This is no longer the recommended way to uninstall the software, please use the RED (Remote
Embedded Deployer). If that is not possible this method can still be used as an alternative.
See 'Terminology: RED on page: 

Log in on the web site of the Ricoh multi-functional.

Choose 'Configuration'.

4
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Choose 'Install' under the 'Extended Feature Settings', if this link is not visible not enough rights are
available, please login with the proper credentials.

Make sure to select 'Local File', no radio button is currently selected, browse and select the
installation file.
Select the app, in this case: 'IneproReaderPlugin_signed_yyyymmdd.zip', and click install.

Click 'Display Extended Feature List', the file will be loaded and the Extended Feature List will be
opened.



48 - Inepro Card Reader plugin for Ricoh SOP

Appendix IV: Deploy the solution manually

Confirm installing the extended feature, and click .

Go back to the 'Install' step on page   and repeat the process untill all the apps are installed.

 If the installation is successful 0 applications should be listed in the application list in the install
section, if the installation was unsuccessful either an error message will appear or a blank screen (as
shown here below).

If the installation was a
success, the number of
applications (that can be
installed), should now be 0.

If the installation failed, either an error
message is shown or a blank page like this.

Contact Inepro Support

 Reboot the machine

Reboot the machine by using the on/off switch. Wait untill the device does not make any sound and
all the lights are off, before switching it on again.

47
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Appendix V: Card Data Encryption

Configuring Card Data Encryption

 Warning: To use card data encryption Inepro Card Reader Firmware version
43.1.1188 or higher is required!
To use card data encryption you need to have your card reader configured with an encryption key.

Refer to the Card Reader Configuration Tool manual to enable encryption in the reader.

Enable Card Data Encryption
To enable card data encryption on the device create an '*.pluginconfig' file containing the encryption
key (in this example "AABBCCDD00112233" is used):

{
  "ENCRYPTION_KEY": "AABBCCDD00112233"
}

Alternatively spacing between the characters is also allowed.
{
  "ENCRYPTION_KEY": "AA BB CC DD 00 11 22 33"
}

 Warning: Make sure the 'Code Brackets', 'Key' and 'Divider' are left unchanged, and
only the 'Value' is changed.
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Disable Card Data Encryption
To disable card data encryption on the device create an '*.pluginconfig' file containing an empty
'encryption key' value:

{
  "ENCRYPTION_KEY": ""
}

 Warning: Make sure the 'Code Brackets', 'Key' and 'Divider' are left unchanged, and
only the 'Value' is changed.

Upload the encryption configuration
1. The Card Reader Service Configuration Page can be reached using the following URL:

http(s)://<ip-address>/rws/sop/inepro/cardreader

After logging in, using the Ricoh credentials, the Card Reader Service Upload Page will be shown:
2. Upload the encryption *.pluginconfig file by ticking the 'Card Reader Service Configuration' box

and click upload:

The last update information in the lower right corner should report that the upload was successful
and more importantly that 'Encryption Key Used' is now 'True'.

The card data encryption configuration has now been activated  
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Appendix VI: RED Functions

RED Functions
In this section some other functions of the RED (Remote Embedded Deployer) are described.
See 'Terminology: RED on page: 

Import Devices
Devices can be imported via *.csv (a comma (',') separated values text) files.
To understand the structure it can be helpful to first add one or two devices and then export them to
*.csv.
To import a *.csv file:
1. Go to the 'File' menu and click 'Import devices..'.

Export Devices
1. Select one or more devices, by ticking the check boxes.
2. Go to the 'File' menu and click 'Export devices..'.

Set Business Server Address
1. Set the IP-Address or host name of the Business Server.

Set SP Settings
The SP settings of a MFP, are the internal configuration settings. These must be set correctly for the
Inepro Reader Plugin and/or Inepro Apps to work. This will be done automatically with full
deployment, however in case it is needed to separately set these settings:
1. Select one or more devices, by ticking the check boxes.
2. Go to the 'Devices' menu, click 'Set SP Settings'.
See 'Terminology: SP Settings on page: 

Reboot Devices
To reboot a device:
1. Select one or more devices, by ticking the check boxes.
2. Go to the 'Devices' menu, click 'Reboot devices'.
3. Do not refresh until the status and detail fields have been changed.

Uninstall all Inepro Apps
This action will uninstall all Inepro applications and revert specific MFP configuration back to default.
1. Select one or more devices, by ticking the check boxes.
2. Go to the 'Devices' menu, click 'Uninstall all Inepro Apps'.

Logs
To troubleshoot a problem you first and foremost need to look at the log files. To provide more
accessibility to those files an internal viewer is available.
1. Click 'Open log' in the 'Help' menu.

Settings
The Settings are mostly options that can be enabled or disabled. Additionally the Business Server
address and the language of the tool are also set here.
See 'Terminology: Business Server on page: 

4
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Setting Descr iption

Force Installation 'Force Installation' w ill ev en install ov er an installation w ith the same v ersion number.

Install O nly
With 'Install O nly ' the applications are just installed or updated w ithout making changes to the MFP
configuration.

A uto Sav e Mode

A lway s Sav e - A lway s sav e dev ice  list

A sk for confirmation - A sk confirmation to sav e dev ice list

Nev er Sav e - Nev er sav e the dev ice list.

A uto Load A lway s load dev ice list when opening this application.

C onfigure C ard Reader Must card reader settings be pushed during a 'deploy '?

Business Serv er A ddress This sets the Business Serv er address (O nly  needed w ith DocuPRO  or KUA RIO  Embedded installations).

Language This sets the language of the tool. It has no effect on the languages on the dev ice.

Make sure the settings are set as you need them to be, if unsure contact the dealer support
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This area is meant for the reader's notes:
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